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Cue Player Lighting came about as a need at the theater, where I serve as Technical Director, to replace
our aging Horizon system. It runs via a parallel port to dmx converter box and although it served us well,
the fear was that should anything happen to it we would be 'up the creek'.

I choose the Enttec Pro as a viable replacement interface and modeled the software user interface after
the Horizon system and that of Cue Player Premium.

There was also the need to be able to run a show with just one booth operator. Rather than have that
person go back an forth between two keyboards, Cue Player Lighting was built to be able to act as a
slave to the sound program. One cue list (albeit a large one) and one keyboard.
Copyright © 2018 by Baxel Data Systems. All Rights Reserved.
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The installer will create a Cue Player Lighting folder and copy in the files:

            CPLighting.exe - the main executable to run

            CPLighting.ini - the settings file (I'm not a registry fan)

            CPLighting.lfix - the fixtures data file

            CPLighting.spch - the soft patch table

            CPLighting.gels - the translation of gel numbers to colors

            CPLighting.scne - the saved scene cues

            Sample.cue - an example cue file

            Sample.fmap - a sample fixtures to dimmer map

There will also be a couple uninstaller files should you want to do that.
Copyright © 2018 by Baxel Data Systems. All Rights Reserved.
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Main Home page - www.baxeldata.com

E-mail - support@baxeldata.com
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Baxel Data Systems is known primarily for the Cue Player Premium software package. That software
controls the sound effects and video projections in over 800 theaters, churches, and schools around the
world.

Our focus is to bring comprehensive, affordable tools to the entire theater community, not just the 500
seat houses. I am technical director at a theater, the software is used and developed there, not in an
office by people who have never done a live show. Any new version has gone through the run of a show
at our theater before being released.

Baxel Data also has non-theater software, notably Kart Tracker. That package will time, display and
announce a race of radio controlled cars at an arcade. If you go to the Baxel Data web site you will also
see a variety of free tools I've developed along the way.
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The Tool bar has icons for most of the tasks of setting up a cue list and running a show. Patching,
Fixtures, and Preferences are on the bar, but discussed under their own Help topics.

  The first group is the Files section. The icons trigger the activity for creating a New cue
file, Loading an existing cue file, or Saving As (for backup) the current cue file. Individual Cues in the
current file are saved via the Record icon as the show is developed, so there is no Save icon.

  The edit group has the triggers for Cut, Copy, Paste, and Save as.... Selecting a cue
in the list will gather all the dimmer levels for that cue. Cut will remove the cue from the list, but keep the
levels in memory. Selecting another cue in the list and clicking Paste will insert the the saved cue above
the selection. Copy follows the same action, but keeps the current cue in place as well. Save as... will
allow you to enter a cue call number and save the cue at that point. It is possible to overwrite existing
cues that way, so a reminder prompt will appear in that case.

  This is Add, Change Channel, Insert After, Insert Before, and Delete. Before
and After would be relative to the currently selected cue. Delete will simply remove the cue from the list.
The add screen will appear for both Add and Insert:
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 Here you can enter the cue call number, select the cue type, set the color for the Description text, and
then the text itself.

The Cue Type dropdown shows 4 choices: a normal DMX cue for setting light levels or fixture settings,
a cue that uses another cue file to run (nesting), a Followspot alert, using the included program
'playwin.exe', and an Open Sound Control (OSC) command to be sent.

A file cue could be something like a chase or lightning that you created as a seperate cue file. With an
additional monitor connected to this computer, the Followspot alert will show the cue description on
that monitor in the background color of the cue text here. The network connection is defaulted to port
5200 for host 127.0.0.1 (the local machine).
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Selecting an OSC command will change the widow to this:

The parameters for the OSC command are the command itself, the IP address of the receiving device,
and the port number that device is listening to.

Following that are the characteristics of the cue itself. If Auto Play is checked, the cue will execute when
clicked or after the previous cue has completed. For a quick sequence of cues, using a timecode trigger
may be needed. A timecode generator is available from the Baxel Data website. Advancing after a time
allows for running several fades at once. The cue will start and if the next cue is set to Auto Play, then it
too, will run after the entered delay. Although similar to entering a wait time in the Auto Play cue, if the
same channel is changed in both cues, the rate of change will be different. Looping over several cues is
allowed. The number of the starting cue and how many loops can be entered. The loop can be stopped
immediately by the Stop button on the toolbar or the Pause/Break key. If the Space Bar is pressed,
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then the loop will finish a cycle before moving on.

The currently selected cue can be moved up or down in the cue list via the arrows.

Cues can be a Single fade, Split fade or Master fade. A Single fade starts after the Wait time and
proceeds over the Fade time to move all the selected dimmers to their new values, brighter or dimmer.
A Split fade will treat the dimmers going brighter and those going dimmer differently according to the
values set in the Wait and Fade values. A Master fade will fade out all channels, including any settings of
an active submaster. All transitions are stored by channel so multiple scene fades can be active at the
same time.

The current channel values can be stored in their entirety as a scene for future use. This screen will open
to allow additions and selection:

When you save a scene you may name it what you wish, Save, and it will appear as the next line item.
When recalling a scene, click on one of the listed lines. To delete a scene, blank out the name. The
leftmost button will change titles from Save to Delete. If you select a scene, buttons will appear to allow
you to Overwrite the current channel levels with the ones from the scene, or to Add the scene levels to
the current ones. A scene may be assigned to a bumpbutton. The far left dropdown is used to select the
key to enable or blank to disable. Whether bump scenes are added to the existing levels or are the
levels themselves is set in the "BumpOvrRpl=" entry of the CPLighting.ini file. 1 is add, 0 is alone. When
working with a cue file set to use its own auxillary files, the Use Rep checkbox will switch the selection
list to that of CuePlayer itself allowing use of a master scene list.

Change Channel will pop up this screen:
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This allows you to change a channel setting to existing cues. If 'Add to' is checked, then the Channel
number and Level entered will be added to the Cue calls in the list. The list can be individual call
numbers or a range (e.g. 1,4,8-20). Useful when a light is added to or removed (level=0) from existing
cues. Checking will change the level of the channels in the list from an existing level to another. For
example, channel 10 could be changed to level 80 only where it is currently 50 in the list range. If 'Move
to Channel' is checked then the level of the Channel will be transfered to the "move to" Channel. The
original channel level will become 0. Useful if you're moving a light from one channel to another.

 The runtime group has buttons to turn Blind mode on or off,  Autoadvance on or off,
to Record the current cue levels (the Enter key will also record), and to Play a cue. The space bar will
also Play the cue. To Play a cue immediately, without fades, right click the Play button. Pressing the
space bar and the Ctrl key together will also play the cue immediately. Turning Blind and/or
Autoadvance off is useful during cue setup and can be toggled with the F4 and F5 keys so you don't
have to use the mouse.

  The first X will break out of a loop or stop a running cue. The Pause/Break key will also. The
second X is the Blackout button. All dimmers will be set to their minimum value, which may or may not
be zero. The ESC key will also do a blackout.

  These buttons are for the additional functions of setting up Softpatches,
Submasters, Fixtures (LED lamps), Groups, Magic Sheet, Preferences, and Connecting to Cue Player
Premium. These functions are explained under their own Help topic.
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 The Cue list has 4 columns. The first is the Cue Call or the number of the cue that the stage manager
will call to be played. The second is the description of the cue as it relates to the show, where the light
is, what action is taking place, etc. The third is the Time or duration of the cue, in seconds or tenths of
seconds. If the cue is a split fade, both times will show. The final column displays a blue play icon if the
cue is an autoplay cue. The description will also be indented by one for an autoplay cue. An Advance at
Start cue is indicated by the blue down arrow. A Loop cue will show the curved arrow. The cue you
are sitting in (has been played) is marked in orange. A playing/in process cue will be colored blue and a
progress bar will appear at the top where the 0 is now.

https://www.helpndoc.com
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An Open Sound Control (OSC) cue will be indicated by a small block 'OSC', a cue that runs another
cue file will show a file folder icon.
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  Each channel has its own level box. The
channel number is shown, along with a red alert icon indicating that it is selected for level setting or not,
and finally, a field for the level itself. Cue Player Lighting will support up to 1024 channels. The number
of channels displayed depends on the screen size and will automatically display as many as it can based
on the window size. The additional (leftover) channels will appear on subsequent tabs across the top.
The total number of channels is set in Preferences under "# of Channels".

Channels are selected in the same manner as items in a list in other Windows programs: single click in
the box will select just that dimmer, Ctrl-Click will select individual dimmers, keeping previous ones,
and Shift-Click will select the range of dimmers from the first to the one Shift-clicked. A right-click on a
selected channel will unselect it. Holding the mouse down and dragging will select the channels the
mouse rolls over. The Delete key or clicking any clear area on the main screen will clear all selected
channels.

The level can be set by typing a number in the level field, or from the keyboard. Up and Down arrows
for a change of one, Page Up/Page Down for a change of 10, and Home/End for a change of 100. The
mouse wheel can also be used to scroll values up and down.

 A channel can be locked by double-clicking the box. Once locked, it will not change

https://www.helpndoc.com
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from its current value as cues are run. The intended use is for an emergency or burn-out recovery during
a performance.

Levels for intensity go from 0 to 100. Levels for colors of LED fixtures and scrollers can go from 0 to
255. That is also a Preferences setting.

Commonly used groups of channels can be defined. See the Groups topic for more information.

 Active Submaster channels will have a tourquoise colored dot. If the submaster is taken
down to 0, the dot will disappear.

Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease
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Clock/Timer

  
Normally, the upper right corner of the Main screen shows the current time. The text color is set from
the Preferences screen. During rehearsals, however, there is often a need to record the run time of the
act or show. Right clicking the clock will bring up this menu:

 Selecting 'Start Timer' will change the clock display to this:

 Which is simply a running timer. It can be paused or resumed from the menu,
or the clock can be returned to display.

Created with the Standard Edition of HelpNDoc: Write EPub books for the iPad

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/create-epub-ebooks


CP Lighting Help

14 / 49

Softpatch

Softpatch

  

Softpatch Previous Top Next

 

            This shows the top and bottom of the softpatch screen. The actual height will depend on the
height of the main screen. Softpatching is a powerful way to customize how you control your lights. If
you are not familiar with it, simply, it is the way to have one or more dimmers controlled by a single
channel on the main screen. If there are several lights aimed at a particular portion of the stage at various
angles, this allows you to set the light level with one channel. The ability to do this is enhanced by the
feature of proportional dimming. If you look at Channel 2 in the picture, you will see that dimmer 56 is
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being set. It has the extra notation of /50 meaning that it will, at most, go to 50% of total brightness.
Taking channel 2 from 0 to 100 will therefore have the effect of changing dimmer 56 from 0 to 50.

Fixture mapping makes it easier to work with LED fixtures. It allows one channel to control the colors
and intensity of a fixture. In this example, there are LEDs with their address settings at 230, 250, and
260. That is, 230 is the dip switch setting, Red may be at 230, Green at 231, Blue at 232, and Intensity
at 233. All that is specified in the fixture's profile. With fixture patching, entering "100R80" into the
channel field of channel 12 will set all of those 230-233 channels to the right value. A right click of the
channel field bill bring up the fixture's color picker so any other color can be selected and mapped to the
correct 230-23x channels. Rather than the complete "100R80", just an intensity value or just a gel
number from either the gel wheel or the user wheel can be entered. This also allows for easy grouping of
multiple fixtures. For example, if there are 4 identical  fixtures covering an area of the stage, they can be
set closely together up in the 400's, but fixture mapped so that channels 10-14 control them, it makes it
easier to write cues. They could even be set as a Group so that "g4" selects all of them.

The Description column has the text that will appear as a hint when the mouse is hovered over a channel
box on the main screen. If the word "nbump5" is in the description, then that channel will bump to 100%
when the F5 key is pressed. "nbump6" works with F6, "nbump7" with F7, and so forth up to 12. If the
word is changed to "fbump5", then rather than a zero count fade when the key is released, a timed fade
will happen. The time is determined by the "BumpFade=" entry in CPLighting.ini. A value of 10 is one
second, 5 is 500 msec., for example. Timed bumps for F5 would be done with "tbump5(x.x)", where
x.x is the duration in seconds. For example, "tbump7(4.3)" would bump the channels where that was in
the description for 4.3 seconds when F7 was pressed, even when released sooner. Entering "abump5"
acts as a toggle switch for that channel and key. Any toggled keys will display on the top line above the
clock.

At the bottom of the screen, the Unpatched Dimmers button will show a window with a list of all the
available or unassigned dimmers. Sorting the rows can be by Channel or by Dimmer. Save will record
any changes and Exit will close the screen without saving.
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  There are 8 submasters available in Cue Player Lighting. When the
Record button is clicked, any channels with an active red dot will be recorded into the submaster at
their current level. An easy way to select channels is to use the "g/" keystrokes to select all active
channels. The sequence would be to have the scene levels you want to have on the sub be visible, its
channels selected with red dots, have the sub slider at the top, and then click Record. The submasters
are additive with a Higher Takes Precedence based on the previously run cue.

 The Add/Edit screen looks like this:

 It is opened by clicking in any of the 8 top description boxes. The
Description is shown as the top line for that submaster, the Hint when the mouse is over that top line. A
submaster can also run a loop file independently of the main channel settings. This allows you to bring up
an effect without changing the rest of the stage. Blanking out the Description and saving will delete the
settngs and change the title to 'Unused'.

Submasters can be assigned to a channel via Softpatch. Submasters are numbered after the total
channel count. That is, if there are 128 channels in the main display, the subs are numbered 129 to 136
and can be softpatched to any of the other 128 channels. An example use would be to have a chase
effect as a cue/loop file assigned to Sub 1 (129), pached to 120. If 120 is in a cue the chase is dimmed
and brightened according to 120's value in the cue(s).

You may have a submaster channel selection for the current cue file or an independant one as a Rep
Plot.
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Check the box to use a Rep Plot and uncheck to align with the current cue file. A good use of the Rep
Plot setting is in conjunction with a slider surface. A midi device like the Pyle  PMIDIPD30 can be used
to control the 8 submaster channels.

Here sliders 1-8 match up to subs 1-8. You could have each sub control a stage area or LED color and
run a presentation or book reading where you didn't want to create a cue file. The Pyle bump buttons
under each slider are active as well.

Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation
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  The Fixtures screen is designed to work with the
newer LED lighting instruments and any color scrollers you may have. The first step is to select a
particular fixture from the top dropdown. One of the options there is to Add a new fixture.
Unfortunately, there are only about 20 profile files included in this install. If you add fixtures, it would be
great if you could forward their settings back to Baxel Data and we will include them in future software
releases.

Having selected a fixture, the starting DMX address of an installed fixture of that type and a Note to be
used as a hint on the main screen would be entered and Save clicked.

If the selected fixture is a moving instrument - indicated by having a channel labeled "Pan" - the color
scroller area will change to this:
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 Here a left click in the box will position the fixture
and a right click will position where the light will go. This will indicate the correct Pan setting in the upper
right corner of the box. The Save button will put the colors and the Pan in the correct channels.

Adding or editing a fixture will bring up this screen:
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The Name and Description are the text you want to recognize the unit by. Known fixtures that have a
local profile already can be loaded via the Load from File button. Newly installed fixtures may have a
known public domain profile. Load from Library will open a file manager window to select the
manufacturer. From the manufacturer, the next file window will show the various models of instruments
they make. The final selection is from the Feature Description field dropdown of that fixture's options:
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The DMX channels for the colors, intensity levels, and movements need to be entered, as well as the
total number of channels to set aside for this fixture. The minimum setting for Intensity can also be
entered. You can select whether the display goes from 0 to 100 or 0 to 255 and enter a channel
description that will show up as a hint for that channel on the main display. When you Save, a file will be
written you can use to Add.

A completed screen could look like this:
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You only need to do this once for each type or model of light instrument installed. This profile is used
when the program is assigning values for color selection and intensity particularly in palette selection.

Going back to the Fixtures screen, having selected a fixture type, the address or addresses of where
these fixtures are installed is entered in the Add and Remove box.
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3 Color 5 Color 

Next, using one or more of those addresses, a color picker can be displayed to choose the combination
of RGB needed to produce the color you want. Also, entering either a Roscoe (Rxx) or Lee (Lxx) gel
number will show its color and corresponding RGB values. If the Show Now checkbox is checked, the
colors will be sent to the fixture as you move the mouse. If the Include Patches is clicked, then any
softpatched fixtures to that address will also show the color. When the Save button is clicked, these
values will be written to all the correct locations for the fixtures you selected.

To make it easier to select often used colors, the concept of a "user palette" is available. The LED
values need to produce various colors will vary from manufacturere to manufacturer and/or fixture type
to fixture type. The values used by each lighting designer to make the colors consistant at a venue can
be saved and recalled.

 Is brought up from the Preferences window and is
used to establish a designer's palette. A new user will automatically be given a 16 color palette of the
Wybron scroller gel colors to start. The "Save to ...." button will switch to the Options tab as described
below. Here is an example of a user palette:
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To use palettes, enter a value in the level field of the palette (abitrarily picked as the Red) channel. For
example, a fixture is set to address 150 and it's Red channel is 1. Normally, Red would therefor be set

by values in channel 150. In the channel display it will appear like this:  Entering a
user palette number in channel 150 (e.g. "D3") while the Shift key is pressed will set all the LED
addresses of the fixture to the stored values for that palette color.
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 To manage the user palette, the Options tab has
selections to Add a new color, as shown in the square above "Show Now" and represented by the
current values in the Red, Green, Blue, Amber, White fields. The colors of an existing gel can be reset
for the palette, the current fixture, or for all fixtures. For example, if you need to adjust the colors for
R80 or B2 for fixture "ABCD" and/or fixture "WXYZ", you can save them here and they will be
recalled when that fixture is selcted. If you have selected a color on a particular channel and you need to
save it to others, select the channels you need to have that color (red dotd), enter the channel number of
the fixture showing the desired color and press Enter or click Save. The color values will be copied to
all the other fixtures of the same type or not.

A right click in any channel box of a fixture will open the fixture window with the installed address
selected.

Entering in the addresses of the scroller channels will allow them to be set from 0-100 or 0-255 as per
your Preferences and not be affected by a Blackout command.

The 'In Use' button will bring up this screen for example:
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 A list of the currently assigned channels and their
fixture names serves as an aid to adding new instruments.

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator
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Groups of channels can be defined to quickly select those channels instead of individually clicking them.
For example, if your blue back lights are in channels 11-16, typing "g5" on the keyboard will
automatically select and show the red dot of all of those channels. Typing "g/" will select all non-zero
active channels in a cue. The entries can come from a file specific to the show's cue file or from a
generic file linked to the program. That is a choice on the Preferences screen. If it is clear and you want
to start with the generic file, click Copy.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation
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A Magic Sheet is a tool that allows a graphical display of instrument locations and channel selection of
those instuments. Groups of lights may be defined or broken out for quicker selection. Clicking on a
channel button here will select and move the mouse to that channel on the channel grid. The intensity and
color are then set as normal. The sheet can be resized and moved as needed. 

Adding a group area is done with a right click anywhere on the sheet.

 This menu will appear. Since the group areas cannot be resized with the mouse,
a choice of starting sizes is offered. Once created, the group can be resized by right clicking within it.

 The menu is also used to name the group and add channels to it.
Once a channel is created, it is named using its own menu.

 Channel buttons may be dragged and postioned anywhere within
their group box using the left mouse and Shift key together. There is a small snap-to feature to make it
easier to align rows and columns of channels.

The intent is to aid cue writting by showing the channels used for various physical locations of
instuments. Additionally, clicking and holding a channel button will light up the light used by that channel.
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LEDs will also get R, G,and B set in addition to intensity so you can see them.

Created with the Standard Edition of HelpNDoc: Full-featured EPub generator
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  This window controls the operational settings for the
program. First, the palette of the current user is identified. That is explained more under 'Fixtures'.
Second, you may select the skin, or appearance of the program. The Help file pictures were taken with
Smart Style or Air 2 selected. Snow Leopard will give an Apple computer look. Setting the Clock color
will affect the running clock in the upper right corner of the main screen. After a cue list is written, it can
be renumbered by the increment indicated. A Warm Up Level other then 0 can be specified and would
be the minimum level for incandescent lamps.

The number of channels used or displayed can be set up to a limit of 1024 depending on the USB
interface. Most interfaces are limited to one universe or 512 channels. It is recommended to set it to the
actual number of channels you have at your venue.

The channels and minmum levels for use with the ETC program Sound2Light can be set. More details
are found under the Connections topic of Sound2Light.
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 The font and font size of the cue list can be set to what pleases you. The background color of the cue
list can be lighter or darker.

The source of the soft patch file, fixture map file, Submasters, Scenes, and Groups can be set to be
either common to CP Lighting or to the current cue file. If you are in a fixed location, "By program"
makes sense, if using a laptop at multiple venues then "By Cue file" may work better for you. When you
create a new cue file, you may choose existing files to be copied as a start.

The change amount for levels at each movement of the mouse wheel can be set to 1, 2, 5, or 10.

 Your color scroller levels can go from 0-100 or 0-255. If 100 is maximum, then they are internally
multiplied by 2.55.

Set Display Refresh determines how frequently, or if, the level settings of the channels scroll to their new
levels as a cue is being played.

Advance then Play will have the cue list behave in a similar fashion to an ETC board. That is, if you are
sitting in cue 50, for example, and the space bar is hit, the program will advance to the next cue and
start playing it. If Advance and Play is unchecked, then the program will behave more like Cue Player
Premium and play the cue line selected.

Prompt for Save or Add will bring up a message box asking if you want to save the current values to the
current cue or add them as a new cue when Enter is pressed. The setting can be toggled by using the
Ctrl key in addition to Enter. This is the prompt:

If you have any color Scrollers listed in the Fixtures screen, Prompt for Scroller cue will bring up a
prompt whenever a cue has a color change asking if you would like to add a cue prior to it to change
the colors before you bring up the intensity.

Next, you can choose to always show the patched address of a softpatched channel when it is clicked
on the Softpatch screen or not. The address is very useful after a cue file is built, but gets tiresome
during construction. 

The last option checkbox will have the program use the dimmer values from a file 'led.txt' in your install
directory. Rather than a straight line dim, the dmx values sent as you approach zero will be more
exponential to give a soft landing to dim. There is nothing that can be done to overcome the 1 to 0 level
dip in inexpensive LED fixtures, but this may help the visual perception of it.

The network address and port number of a computer running Cue Player Premium can be entered and
when the Connect to Cue Player tool bar button is clicked, a connection to that computer will be
established. This will allow that computer to have lighting cues in its cue list so that one operator can
control both sound and lights.

Finally, the port number used to listen for OSC commands from other devices can be set. See the OSC
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help topic for details.
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  Connecting to Cue Player will display an orange dot at the end of the tool bar. The address and
port must have been set in the Preferences tool previously. Cue Player Premium itself will display a Cue
Player Lighting icon at the top of it's main screen to indicate it is connected.

This program will or can continue to run just as if it is not connected. Cues can be selected, edited, run,
etc. without any regard to the connection. If, however, a command from Cue Player Premium is
received, it will execute immediately. There are only 6 commands it will receive: Play ##, where ## is a
cue call number, Goto ##, Stop to stop a loop, Black, which causes a blackout, Next And Back to play
either the next or previous cue. As an example, if you are sitting in cue 40 and the command to "Play
70" comes in, the software will jump to that line and play the cue.

The default port for network connections from CPP is 5085.

To send a command to CPP, you must use OSC. The default address of CPP is /cpsound. To play cue
line 26, for example, enter "/cpsound/play 26" as the command.
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Several options for connections to CP Lighting are possible. If connected, their circle will appear.

As described in the previous topic, a connection to CP Premium for triggering of cues from that
program is indicated by the orange circle.

A connection to the video player for remote display of followspot cues is indicated by the green circle. If
there is a followspot cue in the cue list, the video player window will open automatically and you can
send it to the second monitor. The default port is 5205.

A connection to the remote control app, for either Windows or Android tablets, will show the blue
circle. The default port is 5200.

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites
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Cue Player Lighting can be a client to another OSC application such as Cue Player Premium or a sound
mixer or conventional lighting console.

As delivered, CPL will listen for commands on port 5555 addressed to "/cplight". Valid commands are
"play xx", "goto xx", and "black", where xx is the cue line number of a cue list. The network settings can
be changed by editing the CPLighting.ini file.

There is an OSC test program available on the web site to aid in setup.
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Sound2Light

Sound2Light

Sound2Light is a software product from ETC that monitors an incoming sound stream and outputs OSC
messages depending on the frequency and level of the sound. Up to 4 different frequency bands can be
monitored.
The software is available from this link: ETCLabs/Sound2Light: UNOFFICIAL - A tool converting sound
input to OSC trigger signals. (github.com)

This screen is used to utilize the incoming OSC to CP Lighting:

 The button to brings this up is in Preferences.

The Band is one of the 4 frequency bands S2L outputs. The Dimmer-DMX is/are the lighting channels that
you want to control with the level values in the OSC messages. Min. sets a minimum lighting level that will
be maintained regardless of the S2L message level. If you don't want the channels to go completely out, but
gently flicker, then set this value accordingly.

To have CP Lighting respond to the S2L messages, first send an OSC message of' '../enable', where .. is the
OSC address of the CP Lighting instance. The default is /cplight. The default OSC output port of S2L is
8001. To turn off any S2L response, send '../disable'. 

For example, if you are using Cue Player Premium as your sound source, you would set Premium's OSC
output port to 8001 and then write an OSC cue of '/cplight/enable' to start. Instructions and hints on setting
up S2L inputs can be found on the previously listed link. Then another Premium cue with the triggering
sound file could be played, followed by an OSC cue of '/cplight/disable'.

CP Lighting will be expecting a UDP network protocol and messages of Console Type: EOS from S2L.
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For complex or fixed time sequenced cues, it may be desireable to use a time code signal to trigger cues.
Such code is of the format "hh:mm:ss:ff", where h is hours, m is minutes, s is seconds, and f is frame. This
coding is ommonly used in video productions to time sync multiple camera shoots or with musicians playing
to a click track.
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CP Lighting will accept OSC time code signals in the format "/TC/time hh:mm:ss:ff" whenever the "Enable
TimeCode" option is checked. The default is to listen on port 50555. That may be changed in the
cplighting.ini file in the entry 'Settings > TimeCodePort'.

When 'Enable TimeCode' is checked, the setting for 'Advance then Play' in Preferences is automatically
unchecked as the selected cue needs to advance in order to be triggered by the time code.

If the Baxel Data Systems time code generator is used, it may be started with an OSC cue of '/TC/time
start' sent to the address and port shown on the bottom of the generator screen. Likewise, '/TC/time stop'
and 'TC/time reset' will stop and reset the generator.

Created with the Standard Edition of HelpNDoc: Benefits of a Help Authoring Tool
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            The File menu deals mostly with the creating and loading of cue files. A New Show creates a
blank cue file and Load brings up a file browser to locate an existing file. Up to the last 8 show's cue
files will be listed as Most Recent Shows. It will look like this:

Saving Show as ... is used to create your own backup of the currently open cue file. Changes to the
current file are saved as they are made so there is no plain Save option. Each time the program is
shutdown, a copy of the cue file is made and named xxx_1.lcue, xxx_2.lcue, etc. Up to 4 previous
versions are saved.

https://www.helpauthoringsoftware.com
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Show Cue Spreadsheet will display the current cue list as a spreadsheet which can be used for
documentation. There are buttons on that screen that allow export of the contents as either an Excel
spreadsheet or as a comma separated values (CSV) text file. In the same manner, Show Patch
Spreadsheet will display the soft patches so they can be exported.
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The options menu repeats several of the toolbar icons: Soft Patch, Fixtures, Preferences, and Connect
to Cue Player.

The DMX hardware interface can be chosen. Changing it will dictate a restart of the program. Please
note "Open" class devices are supported as of version 2.1.1.32

The DMX connection type can be via a virtual serial port which is universal, via direct calls to the FTDI
interface library, or by Art-Net. The D2XX connectivity is getting phased out in favor of the virtual
serial. Indeed, the latest dmx interfaces from DMX King require the Virtual Serial connection or Art-
Net, depending n model. The FTDI website will have any updates to the driver from the one distributed
with CP Lighting.

Show Inspection tool opens a viewing window and activates a logging function so you can see all the
commands being sent to the DMX interface. It was used mostly during development of the program, but
may prove useful. It is used to select the Art-Net IP address and allows 'under the hood' settings for
LED fixtures. The tool has its own Help page.

Keypad entry of channel levels is enabled by showing the keypad entry window, either by clicking the
menu or pressing the F2 key.

This window can be positioned anywhere and it's last position is remembered. The syntax for entry is:
"channels*level". A range of channels is written "start/end". For example, "2/10-5+12*80" would set
channels 2,3,4,6,7,8,9,10,12 at 80. Pressing the - key on the numpad will give this window focus at any
time it's open.

http://www.ftdichip.com/Drivers/D2XX.htm
http://www.ftdichip.com/Drivers/D2XX.htm
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Setting the cue width will allow for more or fewer channels to be displayed over the rest of your screen.
Often just the cue number and a short description aids selection.

The Dimmer check goes channel by channel and runs the values up and down so you can check the
lights before a show. You can select automatic advance or manual. Press Esc to exit the check at any
time.

Starting the Web Remote will activate the browser interface tool. It will sit minimized on the lower left of
your screen. You normally do not have to do anything with it on your main screen. See the chapter on
"Web Remote" to learn about the functions available.

Enableing Time Code will activate the network connection to allow OSC time code signals to trigger
cue playing. Time Code under Connections has the details on use.

Enableing StreamDeck will enable use of a StreamDeck surface to select and display cue lines and then
trigger them via the Deck. Stream Deck under connections has the details on use.

1 to 1 patch mode bypasses the softpatch file and maps channel 1 to dimmer 1, 2 to 2, etc.

Locking out Cue changes sets a flag such that the current cue file cannot be changed. It is remembered
for the file and established whenever the file is reloaded. Unchecking the flag allows changes and will be
remembered as well.
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The Web Remote tool allows editing your cue list from a browser on your phone or tablet.
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To view this screen in your browser, enter the IP address of the computer Cue Player Lighting is running
on followed by a colon and the number 8008. e.g 192.168.0.20:8008. You can check for the IP
address in the Help > About popup window.

To play a cue, tap the 'Play' button and then the number of the cue line, followed by the 'Send' button.
Setting a channel to a level is done with the 'Set' button, the number of the channel, the '@' button, and
finally the level. For example "Set 20@30" will set channel 20 to level 30. Use the + and - buttons to
adjust the level.

To find out the current level of a channel, tap the channel box to clear it, then enter the channel number,
followed by the 'Read' button. The 'Record' button will write all your changes to the cue you last played.
Use 'Next' and 'Back' to play the  next or previous cue lines.

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites
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Inspection Tool

Inspection Tool

  
The Inspection tool is used to observe the program's DMX output, adjust any problems with LED
fixture settings, and set the Art-Net IP address.

When the tool wiondow is open and a cue is run, the DMX output levels are displayed:
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The Read Fixtures button will show a list of the fixture library with the fixture number for each name:
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The numbers identify which fixture may be assigned to a DMX channel.

The addresses and fixture numbers are stored in a set of tables called the 'Fmap'. There are three
sections to the map and they can be viewed by the Read Fmap button:
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and scrolling down:
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Fmap(0) stores the starting address and number of channels for each fixture in use. For example, we
can see that at address 140 there is a 6 channel fixture in place. The number 2000 is a dummy number
for scroller channels.

Fmap(1) has the minimum intensity level for each address. In this case we have a minimum level of 1 for
all conventional instruments. A -1 indicates a color, strobe, or macro channel and won't be changed by
a Blackout command.

Fmap(3) contains the fixture number installed at that address. So for our example, there is an Aurorae
P180 set to address 140.

Should it come about that through installs, removals, rehangs, or whatever these relationships get out of
sync and are not accurate, then the fields and buttons in the lower left can be used to rewrite them. If we
were to put 140 in the DMX addr. field and click Read, then Start would show 140, Dim would show -
1, and Fixture would show 2. Editing any of the fields and clicking Write will change the Fmap
acordingly.

To start from a clean Fmap, meaning you will need to enter the current addresses of all installed fixtures
with the fixture tool, click 'Rebuild Fmap'.

Art-Net

The setup for Art-Net requires that the IP address of the interface(s) be known to CP Lighting. The Poll
button will send out the commands over the network that cause interface devices to respond back with
their name and address. That will populate the drop-down box.
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Clicking Pick 1 will set the displayed address as the one to use for Universe 1. Clicking Pick 2 does the
same for Universe 2. They do not have to be the same device. Back on the Options Menu, clicking
either of the Art-Net options will bring up this screen.

Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator
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The keyboard can be used in the following manner:

Esc - clicks the Blackout button, stops a dimmer check

https://www.helpndoc.com/feature-tour/iphone-website-generation
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F2 - displays the Keyboard entry window

F3 - toggles the AutoAdvance button

F4 - toggles the Blind/Live button

F5-F12 - the Bump buttons

Pause/Break - clicks the Loop Break button, stops a cue

Home - adds 100 to all active channels

End - Mouse on grid: subtracts 100 from all active channels. 

         Mouse on cue list: If a cue is running, completes the fade and cue.

Page Up - adds 10 to all active channels

Page Down - subtracts 10 from all active channels

Up Arrow - adds one to all active channels

Down Arrow - subtracts one from all active channels

g# - (where # is 0 thru v) - selects the channels of that group number

g/ - selects all non-fixture channels with greater than warmup value

b or Backspace - Mouse on cue list:  runs the previous cue with timer

Space Bar - runs the next cue with timer, completes running loop

Alt - used with a number in a channel - enters values of a user palette

Ctrl - used with b, Backspace, or Space Bar - runs the cue immediately from screen values

            Toggles the Record cue mode between Save and Add

Delete - Mouse on grid: clears all selected channels. 

             Mouse on cuelist: If a cue is running, stops the fade and completes the cue.

Enter - records the current levels or saves the current timings/description

Shift - used with Enter adds a cue with current levels. Used with Space Bar loads and sends the current
values of the channel grid.
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Help Menu

Help Menu
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The Help menu has options to redirect you to this file, show you your Registration details, and to bring
up a window with the version and copyright information.
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Keypad entry of channel levels is enabled by showing the keypad entry window, either by clicking the
menu or pressing the F2 key.

This window can be positioned anywhere and it's last position is remembered. The syntax for entry is:
"channels*level". A range of channels is written "start/end". For example, "2/10-5+12*80" would set
channels 2,3,4,6,7,8,9,10,12 at 80. Pressing the - key on the numpad will give this window focus at any
time it's open.
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How or where can I get an interface to use with your software?

            The Enttec Pro can be purchased from Enttec or several distributors on the web. DMX King
also makes a compatible interface that has proven reliable.

I already have an XYZ2000 (or whatever) hardware interface for DMX. Can I use it with your
software?

            If the interface says it is "Enttec compatible" then it should work with the program. If not and
you send me the make, model and the communication source code for the device, I will make every
effort to translate it for Cue Player Lighting.

You say in the feature list that the Velleman interface has limitations. What are they?

            Unlike the Enttec interface that gets all the lighting levels in one message, the Velleman VM116
requires that each channel level is transmitted one at a time. This results in delays that makes the
dimming steps noticeable. At the present time, using the VM116 is not recommended for use with more
than 32 channels with Cue Player Lighting. That may change in the future. As of version 1.9.1, the
Velleman interface was removed from the selection menu.

 How do I run the program as a non-Administrator? - The program needs to be "Run as Administrator"
during the registration process. An easy way to do that is right click the desktop icon and then select
Run as Administrator. Once you have your registration key and have registered the program, you may
remove or rename the file "cplighting.exe.manifest" in the installed directory.

Can I use an "Open" class interface like the Enttec Open? - Yes, BUT, the Open interface uses the host
computer for timing the DMX signals that can lead to issues with entry level computers and a large
number of lights. Our experience is that for about the same cost, the DMX King Micro with its internal
timing is a better alternative.

I want to use a surface with sliders instead of having a cue file for everything. - You can connect a midi
sound controller such as the Pyle PMIDIPD30 via a USB port and control the 8 submasters with the
sliders.
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How To Buy

How To Buy

 

How To Buy Previous Top 

Cue Player Lighting is $99.95 and you can purchase a license key from Share-It.
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